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1 Scope 
The scope of this guide is to provide an overview to assist users, who have a basic 
knowledge of Microsoft Excel, with Section 508 compliance when creating Microsoft Excel 
documents. Documents must be accessible to all individuals including those with 
physical, sensory, and cognitive disabilities. These guidelines cover the Section 508 
requirements and best practices for Microsoft Excel established by the U.S. Department 
of Health and Human Services (HHS). 
Microsoft includes several options/techniques to perform functions. This guide provides 
one set of keyboard accessible instructions, where possible. For more detailed 
information on step-by-step Excel instructions, please refer to the Microsoft Office 
website. 

https://support.office.com/
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2 Microsoft Office Accessibility Checker 

2.1 Accessibility Checker 
Microsoft Office now includes an easy-to-use Accessibility Checker tool to help ensure 
documents are Section 508 compliant, i.e., accessible to people with disabilities. 
Like the spell checker helps to identify possible spelling errors, the Accessibility 
Checker helps create accessible content by: 

• Identifying issues which might cause problems for people with disabilities in 
reading or using the content; and 

• Providing a task pane to view and fix these issues before the content is 
finalized. 

Please note the Accessibility Checker is not a substitute for using the HHS 508 
compliance checklists. However, it is a great supplemental tool for easily finding and 
fixing accessibility issues overlooked when using the checklists. The Accessibility 
Checker not only finds accessibility problems, but it also explains why the problem must 
be fixed and how to fix it in easy steps. 

2.2 Accessibility Checker Errors, Warnings, and Tips 
There are three categories of accessibility checker issues possibly encountered by a 
person who is using assistive technology to read a document: 

• Error – Content making the document difficult or impossible to read and 
understand. 

• Warning – Content making the document difficult to understand. 
• Tip – Content people with disabilities can understand, but could be presented 

in a different way to improve the user’s experience. 
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The following table gives a brief description of each accessibility rule the Accessibility 
Checker looks for and verifies in a Microsoft Excel document, grouped by category of 
issue: 

Accessibility Rule Category Accessibility Checker Verifies 

Add alternative text (“alt text”) to 
all objects—including images, 
graphics, grouped images, 
tables, charts, and non- text 
elements—conveying 

 

Error All objects use alt text. 
Alt text does not contain an image 
or file extension. 

Specify column header rows in 
tables. 

Error The Header Row box is selected in 
the Table Tools Design tab for each 
block of cells marked as a table. 

Use hyperlink text to provide a 
meaningful description of the link 
destination (i.e., a name or 
phrase), instead of only the URL. 

Warning Link text includes a ScreenTip and 
matches the link destination. 

Use a simple structure for tables 
to make them easy to navigate. 
Do not merge or split cells in a 

 

Warning Tables do not contain split cells, 
merged cells, or nested tables. 

Do not use blank cells, rows, or 
columns to format tables. 

Warning Tables do not contain blank cells, 
rows, or columns. 

Rename the default sheet tab 
names, giving them unique 
names. 

Warning All sheets with content in a 
workbook have a name other than 
“Sheet1,” “Sheet2,” etc. 

Include closed captions if you use 
audio or video in a document. 

Tip All audio and video clips in the 
document have closed captioning. 

2.2.1 How to Use the Accessibility Checker 
1) Select the File tab, then select Info. 
2) In the “Info” Backstage View, select the Check for Issues button, and 

then select the Check Accessibility option from the menu. 
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Figure 1: “Check for Issues” Button Including “Check Accessibility” 

 

The document reappears, and the Accessibility Checker Task Pane appears along the 
right side of the screen, displaying the Inspection Results. 

Figure 2: Accessibility Checker Task Pane 

 

3) Click on a specific issue to view Additional Information and steps to 
change the content. 
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3 Layout and Formatting 

3.1 Structural Tags 
Structural tags are unseen labels for the type and structure of content in an Excel 
workbook (i.e., tables, column headers, charts, images, etc., as well as their order and 
hierarchy). Structural tags allow assistive technologies to easily navigate a document. 
Structural tags are automatically transferred into PDF files when Microsoft Office and a 
full installation of Adobe Acrobat Professional are properly configured to pass along this 
encoded information. 
Word’s automated Table of Contents (TOC) and Bookmark features, are an example of 
structural tags in action. Word scans all tags in the document, identifies the heading 
hierarchy and the location of headings, and compiles the TOC. 
Layout and Formatting Dos and Don’ts: 

• Remove blank/unused worksheets. 

• Name each worksheet. 

• As recommended by HHS, use the font type Times New Roman, Verdana, Arial, 
Tahoma, Helvetica, or Calibri. 

• Use font size 12-point or greater as a guide, but keep in mind fonts in the same 
point size can vary due to differences in the style of the letters. 

o Instead of specifying a point size, use this pragmatic rule: Make the type 
large enough for easy reading by the intended audience. 

• Use dark-colored lettering on a white or light-colored background. 
o Documents must have a color-contrast ratio of 4.5:1. 

• A cell can only store one piece of data at a time, i.e., a formula, text value, 
numeric value, or date value. 

• A URL must appear in a cell by itself to link to a Web destination. 
o The URL must be included either in the cell immediately below the link text 

or inside parentheses in the cell immediately after the link text. 

• An e-mail address must appear in a cell by itself and link to an e-mail destination. 

• Do not use flashing, flickering, and/or animated text. 

3.2 Sheet Tabs 
By default, a new workbook contains three worksheets named Sheet1, Sheet2, and 
Sheet3. Each worksheet should contain a clear and concise name (title or description). 
As a best practice remove any blank sheets. 

3.3 Color Emphasis 
Use color only as an enhancement, not as the sole means of conveying information. To 



CMS Section 508 Guide for  Layout and Formatting 
MS Excel 2013 

Centers for Medicare & Medicaid Services 6 

use color to emphasize the importance of certain text, also incorporate an alternative 
method such as bold, italics, or asterisk (*); do not use color alone. 

3.4 Underlines 
Use underlines only for hyperlinks to websites (URLs), e-mail addresses, documents, or 
specific content within a document. Do not use underlines to emphasize text; they can 
make text difficult to read. 

3.5 Merged Cells 
Merging cells in Excel is only permitted in the first row (A1) of the worksheet, typically 
the row containing a title. As a rule, merged cells should be avoided. 

3.5.1 How to Merge Cells (First Row ONLY) 
1) Select cells to merge together. 
2) On the Home tab, select the Merge & Center drop-down arrow, and then 

select Merge Cells. A warning message will appear stating the first cell 
text will be applied. 

Figure 3: Home Tab, Merge & Center Tool and Drop-down Arrow with Merge Cells Selected 

 

3) Select OK. The merged cell will appear. 

3.6 Links (URLs and E-mail Addresses) 
All Web citations (URLs) must provide the correct hyperlink and must include the full 
address.  
URL Dos and Don’ts: 

• Place meaningful text either in parentheses or directly below the URL link text. 
o Use link text that clearly describes the content of the website it links to (six 

words or less). 

• Place a URL in a cell by itself and link to the Web destination. 

• Avoid using “Click here” or “Read more.” 
E-mail Dos and Don’ts: 

• E-mail addresses must link to an active address. 
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• Use the name of the addressee (contact person) as the link text (e.g., Jane 
Doe). 

• Avoid using “Click here.” 

3.6.1 How to Create a URL Link 
A URL must be in its own cell in order to edit the hyperlink text, etc. (if necessary). This 
means that descriptive text will be in one cell and the URL will be in an adjacent cell. 
The end result of the two cells will give the “appearance” of a single cell, this is also 
known as a two-celled sentence. 

1) Type the text describing the URL in a cell (e.g., “To get more information 
about diet, nutrition, and eating right, go to”). 

2) Type the URL in the cell to the right of the text in Step 1 (e.g., 
“https://www.cms.gov”). Upon hitting the Enter key, the URL will activate. 

3) To modify the name of the URL, select the URL. 
4) Select the Insert tab, then select Hyperlink. An Edit Hyperlink dialog box 

will appear. 
Figure 4: Edit Hyperlink Dialog Box Displaying “Text to display:” Field Completed 

 

5) Verify the Existing File or Web Page is selected in the Link To: column. 
6) In the Text to Display: field, type a name or brief description that will 

appear as link text for the Web address (e.g., HHS home page). 
7) Select OK. The link text “HHS home page” will appear in the cell and also 

in the Formula Bar. 

3.6.2 How to Create an E-mail Link 
An e-mail address must appear in a cell by itself and link to an e-mail destination. 

1) Type the text of the e-mail information in a cell (e.g., “To get additional 
information, contact”). 

2) Type the e-mail address in the adjacent right cell (e.g., 
jane.doe@cms.hhs.gov). Upon hitting the Enter key, the e-mail will 
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activate. 
3) Right click on the e-mail address cell and select Edit Hyperlink. The Edit 

Hyperlink dialog box will appear. 
4) Verify the E-mail Address section is selected in the Link To: column. 
5) In the Text to display: field, type the name of the addressee (contact 

person) as the link text for the e-mail address (e.g., Jane Doe). 

3.6.3 How to Create a ScreenTip 
A ScreenTip appears when placing the cursor over a link. ScreenTips enable people 
using assistive technology to identify an active link. 

1) Select the cell with the link (e.g., HHS home page). 
2) Select the Insert tab, then select Hyperlink. An “Edit Hyperlink” dialog 

box will appear. 
Figure 5: Set Hyperlink ScreenTip Box Displaying “ScreenTip text” Field Completed 

 

3) In the “Edit Hyperlink” dialog box, verify the Existing File or Web Page 
in the Link to: column is selected. 

4) Click on the ScreenTip button. A Set Hyperlink ScreenTip box will 
appear. 

5) Type a brief description in the Set Hyperlink ScreenTip box (i.e., “Link to 
the HHS website home page”). 

6) Select OK. Then select OK again to exit the Edit Hyperlink dialog box. 
For verification of the ScreenTip, move the cursor over the link and a gray 
box containing the ScreenTip will appear as shown below. 

Figure 6: Two-Celled Sentence with Link Text and ScreenTip Displayed 
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4 Images and Graphics 
Images and Graphics Dos and Don’ts: 

• Apply alternative text to appropriate images and graphics. 

• Group multiple associated images as one image. 
• Every chart (e.g., bar graph, pie chart) must have a title, a legend, and axis 

labels (if applicable). 
• Do not use background images or watermarks in the document. 
• Do not use SmartArt.  

4.1 Alternative Text (Alt Text) 
All images, grouped images, and non-text elements conveying information must have 
alternative text descriptions (also called “alt text”). Alt text allows people with disabilities 
equal access to the information conveyed by the image, grouped image, or other non-
text elements. Non-text elements include (but are not limited to): 

• Charts 
• Diagrams 
• Graphs 
• Logos 
• Screenshots 

Alt text is not necessary for images which do not convey information, such as images 
that are purely decorative or redundant with the text. 

4.1.1 How to Add Alt Text 
1) Right-click on the image. 
2) Select Format Picture from the drop-down menu. A Format Picture 

dialog box will appear on the right side of the screen. 
3) Select Size and Properties icon. 
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Figure 7: Format Picture Dialog Box Displaying Alt Text Fields 

 

4) Select Alt Text, and the fields for Title and Description will appear. 
5) In the Description field, type a brief but complete description of the image 

and the key information it is conveying. 
Note: It is not necessary to complete the Title field for alt text. 

4.2 Grouping Images 
Multiple associated images (e.g., individual images, objects, or graphics) on a page 
making up one combined graphic, such as boxes in an organizational chart) must be 
grouped as one object. 

4.2.1 How to Group Multiple Images into an Object 
1) Click on each object one at a time. For each object, select the Page 

Layout tab on the Word toolbar. 
2) Hold the Shift key, and click on each object. 
3) In Page Layout, select Group drop-down, then select Group again. 

Figure 8: Page Layout Tab, Group Tool 
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4.3 Charts and Graphs: Title, Legend, and Axis Labels 
Every chart (e.g., bar graph, pie chart) must have a title, a legend, and axis labels (if 
applicable). Generally, Word adds these automatically when creating charts and graphs 
with the Excel tool. 

4.3.1 How to Add Labels for Charts and Graphs 
1) Click once anywhere in the chart. This activates the following three Chart 

Element tabs: Design, Layout, and Format. 
2) Select Chart Title or Axis Title, etc. 
3) Select the appropriate option from the next drop-down menu (i.e., Above 

Chart Centered Overlay, etc.). 
Figure 9: Chart Tools, Add Chart Element, Chart Title Tool 

 

4) Type the label title when the placement for the chart or axis title appears. 

4.4 Text Boxes 
Avoid using text boxes. The only acceptable time to use text boxes is if the final format 
will be in PDF or HTML. An alternative to text boxes is to use the “Borders and Shading” 
feature to create a border around a paragraph. 
Note: Even though the newest HHS 508 compliance requirements allow text boxes, if 
the final version of the Word document will be converted to PDF or HMTL, PDF files 
containing text boxes are often problematic, causing assistive technology to read the 
text boxes and surrounding content in an incorrect reading order. Fixing this problem in 
PDF is extremely difficult!  

4.5 Descriptive Text for Complex Images 
For complex images such as a chart or graph, type a brief but complete description in a 
paragraph immediately above or below the image. 
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4.6 Complex Content 
When there is no other way to make complex content in a document 508 compliant, an 
accessible version of the content must be provided in a separate document. An 
example of complex content is organizational charts. In this case, it is necessary to 
provide a separate full-text document describing the content of the organizational chart. 
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5 Comments, Formatting Marks, References, Etc. 
Comments are often overlooked when creating Excel documents. 
Comments, formatting, and references Dos and Don’ts: 

• All comments must be removed when preparing the final version. 

• Accept or reject all tracked changes when preparing the final version. 
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6 Tables 

6.1 Creating Tables 
Tables help organize data and must be created using the Table tool. 
Table Dos and Don’ts: 

• Create only one table per worksheet. Create multiple worksheets in the workbook 
to convey a lot of information. 

• Ensure logical reading order is from left to right, top to bottom. 

• Use a table header row and freeze rows if a table spans multiple pages. 

• Include a cell with “End of Worksheet” in the last row/cell of the table. 

• Avoid merging cells in a table unless the final format of the document will be PDF 
or HTML. 

• Avoid using blank cells, rows, or columns. 

6.2 Table Titles 
In most instances, tables should be labeled with a title consisting of a number and a 
short description, inserted above the table. 
In some cases, it is not necessary to number a table. For example, one or two tables in 
a workbook may not need to be numbered. 
Include a blank row between the table title and the actual table. Excel may mistakenly 
capture and format the table title as a column header, if the blank line is omitted. Also, 
keeping the table title separated from the actual table will enable screen readers and 
other assistive technologies to present this information in the proper reading order. 

6.3 Freezing Table Header Rows 
When a table spans two or more pages, repeat the header row at the top of the table on 
each successive page. This will enable screen readers to re-state the header 
information as the table continues from one page to another. To make this possible, 
“freeze” the header row. 

6.3.1 How to Freeze the Header Row 
1) Click on the first cell in the row immediately below the header. 
2) Select the View tab on the Excel toolbar. 
3) Select the Freeze Panes tool in the Window group. A drop-down menu 

will appear. 
4) Select the Freeze Panes option from the drop-down menu. 
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Figure 10: View Tab, Freeze Panes Tool 

 

6.4 Blank Cells 
Avoid using blank cells, rows, or columns. 
If a cell truly has no data, type something like “This cell intentionally left blank,” “No 
data,” “Not applicable,” or “N/A.” 
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7 File Naming 
There are a few rules to follow when naming Excel files.  
File Naming Dos and Don’ts: 

• Avoid Spaces and Special Characters 
o Do not use spaces or special characters (#, $, &, @, etc.) in file names.  
o Hyphens are acceptable in file names.  
o The following are examples of 508 compliant file names: 

“PartAClaimsByMonth.xlsx” or “Part-A-Claims-By-Month.xlsx”. 

• Never use an underscore in a file name.  
o If a file name with an underscore appears in another document, or on a 

website, as part of a link, the link’s automatic underlining may cause 
readers to misinterpret any underscore as a space. 

• Be Concise 
The file name must be concise, must generally be no more than 30 characters in 
length, and must clearly convey the subject matter of the file. For example: 
“OfficeSupplyBudget.xlsx” or “Office-Supply-Budget.xlsx”. 
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8 Document Properties 

8.1 Document Properties 
The document properties must be completed (e.g., Title, Author, Subject (brief 
description), and Tags (keywords)). 
Document Properties Dos and Don’ts: 

• Do not change the language field to anything other than English (default). 

• Do not enter the name of a person or private organization for the author field. 
The author must be a government organization (e.g., CMS). 

8.1.1 How to Enter Document Property Fields 
1) Select the File tab. If necessary, select Info. The document’s Properties 

will appear in the Backstage View. 
2) In the Title field, type the title for the document. 
3) In the Author field, ensure the author is a government organization (e.g., 

CMS), not the name of a person or private organization. If there is a 
person already listed in the “Author” field, right click on the name and 
select Delete Person. 

4) In the Subject field type a brief description of the topic or subject matter. 
5) In the Tags field, type in keywords. The tags are metadata to be used for 

Web searches. 
Figure 11: Example of File, Info, Properties Screen 

 

8.1.2 How to Verify Language 
1) Select the File tab. 
2) Select Options. The Excel Options dialog box will appear. 
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3) Select the Language tab from the Excel Options dialog box. Notice the 
default language is set to English (U.S.). No further action is needed. 

Figure 12: Excel Options Dialog Box with Language Option Selected 
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9 Converting Excel Documents to PDF 

9.1 Converting from Excel to PDF 
To convert an Excel document to PDF, use the PDF conversion tool. 
Converting from Excel to PDF Dos and Don’ts: 

• The Acrobat tool is the preferred and most reliable method of converting Excel 
documents to PDF to carry over formatting elements and accessibility tags. 

• If the Acrobat conversion does not carry over all the formatting elements and 
accessibility tags, try using File, then Save as Adobe PDF. 

• Do not use the File, Print, Print to Adobe PDF, as this does not properly 
convert the formatting elements and accessibility tags in Excel documents.  

• Before converting the document to a PDF file, view the document in Print 
Preview to verify it flows correctly from page to page. Look for image placement, 
table formatting, and stray (“orphaned” or “widowed”) lines and characters. 

9.1.1 How to Convert an Excel Document to PDF 
1) Select the Acrobat tab. 
2) Select Create PDF and Run Action. 

Figure 13: Create Adobe PDF and Run Action Tool 

 
3) Name and save the file to the appropriate location. 
4) The Make Accessible task pane will appear on the right side of the screen. 

Select the Start button to begin checking for compliance. 
5) Follow the prompts on the screen and answer in accordance to the document. 
6) When the Accessibility Checker dialog box appears, select the Start Checking 

button. Results of the Accessibility Check will appear on the left pane. 
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10 Frequently Asked Questions 
Who is Responsible for Ensuring Excel Documents are 508 Compliant? 
Everyone who works for CMS is responsible for making sure all written materials created 
are 508 compliant, regardless of whether these materials are intended for internal or 
external distribution. Likewise, contractors, state agencies, and other public and private 
organizations receiving federal funding to carry out particular programs or projects on 
behalf of CMS are required to make sure the written materials produced in conjunction 
with those programs or projects are 508 compliant. 
Why is 508 Compliance Important? 
Making a document 508 compliant does not just help make it accessible to people with 
disabilities. It also increases a document’s usability and adds new features everyone can 
use: 

• 508 compliant PDF files can be read aloud using the free Adobe Acrobat Reader, 
providing all the information received by someone viewing the document.  

• The structural tags of a 508 compliant document can turn into a hyperlinked Table 
of Contents in a Excel file or bookmarks in a PDF file, allowing the user to easily 
skip to a particular section in a long document.  

• 508 compliance provides easy ways to view and navigate documents 
independent of the original format, allowing documents to be easily formatted for 
cell phones or other mobile devices. 

What Types of Excel Documents Must be 508 Compliant? 
All written materials must be 508 compliant, regardless of whether they are intended for 
internal or external distribution. The final version must always be 508 compliant. Also, 
working drafts must be 508 compliant if they are being reviewed by one or more 
individuals who have a disability preventing them from reading or navigating the draft.  
Must a Converted Excel File to PDF still be 508 Compliant? 
Yes. In many cases, the CMS component Section 508 Clearance Officer can assist with 
creating a 508 compliant PDF file which may be posted or distributed electronically (e.g., 
via the Internet or e-mail).  
Where is the list of CMS Section 508 Clearance Officers? 
The most current list of CMS Section 508 Clearance Officers can be found on the  
cms.gov Section 508 page (https://www.cms.gov/Research-Statistics-Data-and-
Systems/CMS-Information-Technology/Section508/index.html). 
What is Assistive Technology (AT)? 
People with disabilities may use a variety of technologies, many of which depend on 
structural tags to function properly. Assistive technology allows people with impaired 
vision to enlarge an area of the screen, increase font size, change document colors, 
increase contrast, or even “read” the computer screen using an audible or tactile Braille 
device. 

https://www.cms.gov/Research-Statistics-Data-and-Systems/CMS-Information-Technology/Section508/index.html
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People who are mobility impaired may navigate the screen by means other than a mouse 
or keyboard. Some may use a keyboard with Tab key or Arrow key based navigation. 
Some may use a mouse or joystick with a virtual software based keyboard. Some even 
employ physical input methods such as eye movement tracking, or an oral sip-and-puff 
system controlled by breathing through a tube. 

What if Other Types of Content Not Addressed In This Guide are Used? 
This guide is not intended to be a complete guide to Section 508 compliance. If a 
document contains rich media, such as audio, video, animation, or interactive navigation 
features, additional requirements not covered in this guide will apply. Please see the 
Other Resources Available Section for more information. 
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11 Other Resources Available 
This guide contains content from and expands on the following sources: 

• “Excel Document 508 Checklist”. To get a copy of the checklist, go to the HHS 
Section 508 Website Excel Document 508 Checklist 
(https://www.hhs.gov/web/section-508/making-files-
accessible/checklist/excel/index.html). 

• “PDF File 508 Checklist”. To get a copy of the checklist, go to the HHS Section 
508 Website PDF File 508 Checklist (https://www.hhs.gov/web/section-
508/making-files-accessible/checklist/pdf/index.html). 

This guide also draws from the following Microsoft Office online sources: 
• "Use the acccessibility checker on your Windows desktop to find accessibility 

issues"(http://office.microsoft.com/en-us/word-help/check-for- accessibility-
issues-HA010369192.aspx?CTT=5&origin=HA101999993). 

• "Rules For the Accessibility Checker" (http://office.microsoft.com/en-us/word-
help/rules- used-by-the-accessibility-checker-
HA101823437.aspx?CTT=5&origin=HA010369192). 

https://www.hhs.gov/web/section-508/making-files-accessible/checklist/excel/index.html
https://www.hhs.gov/web/section-508/making-files-accessible/checklist/pdf/index.html
http://office.microsoft.com/en-us/word-help/check-for-accessibility-issues-HA010369192.aspx?CTT=5&amp;origin=HA101999993
http://office.microsoft.com/en-us/word-help/check-for-accessibility-issues-HA010369192.aspx?CTT=5&amp;origin=HA101999993
http://office.microsoft.com/en-us/word-help/check-for-accessibility-issues-HA010369192.aspx?CTT=5&amp;origin=HA101999993
http://office.microsoft.com/en-us/word-help/check-for-accessibility-issues-HA010369192.aspx?CTT=5&amp;origin=HA101999993
http://office.microsoft.com/en-us/word-help/check-for-accessibility-issues-HA010369192.aspx?CTT=5&amp;origin=HA101999993
http://office.microsoft.com/en-us/word-help/rules-used-by-the-accessibility-checker-HA101823437.aspx?CTT=5&amp;origin=HA010369192
http://office.microsoft.com/en-us/word-help/rules-used-by-the-accessibility-checker-HA101823437.aspx?CTT=5&amp;origin=HA010369192
http://office.microsoft.com/en-us/word-help/rules-used-by-the-accessibility-checker-HA101823437.aspx?CTT=5&amp;origin=HA010369192
http://office.microsoft.com/en-us/word-help/rules-used-by-the-accessibility-checker-HA101823437.aspx?CTT=5&amp;origin=HA010369192
http://office.microsoft.com/en-us/word-help/rules-used-by-the-accessibility-checker-HA101823437.aspx?CTT=5&amp;origin=HA010369192
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